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CorelXARA is an advanced graphic illustration package for Windows computers. This viewer
program is based on the full CorelXARA package and lets you display files, not just from this

CD but also from many other sources.    It will let you judge for yourself the speed and
display quality of CorelXARA.

This viewer contains only a few of the tools and menu options available in the full package.
To see the full range of tools in the full package in use, run the Multimedia Demonstration

(click here) on the CD and read the CorelXARA On-line Specification (click here).
Using CorelXARA Viewer

· Loading the example files
· The button bar
· How To...

General Information
· Supported File Formats
· Re-installing Win32s

Copyright Xara Ltd October 1995.
Corel & CorelDRAW are trademarks of Corel Corporation
Illustrator is a trademark of Adobe Systems Inc.
All other trademarks acknowledged



What



The Button Bar
The Button bar is displayed at the top of the CorelXARA Viewer window. You can select functions either 
from the Button Bar or from the Menus.

Open file

Push Tool

 Zoom Tool

      Set View Quality

Clipart Gallery

Font Gallery
Time Redraw

Full screen mode



 
 Push Tool

The Push Tool lets you use the mouse to slide the document around in the window.

Push Tool Operations
Moving the Page

Key Short-cuts
ALT+X
SHIFT+F8



 
 Zoom Tool

The Zoom Tool allows you to alter the magnification of the current document view.

Button Bar Controls

Zoom Command

Previous Zoom Command

Zoom to Page Command

Zoom to Drawing Command

Zoom Tool Operations
Zooming

Key Short-cut
ALT+Z
SHIFT+F7



Commands



CorelXARA Menus
File Menu
Utilities Menu
Window Menu
Help Menu

_______________
See also
The Tools



File Menu
Open Command
Close Command
Document Info Command
1,2,3,4 Commands
Exit Command

_______________
See also
CorelXARA Commands



Open Command (File Menu)
Opens an existing document or file in a supported format in a new window.

To quickly open a document:
· Click the Open button.
· Drag the file from the File Manager (or equivalent) onto the CorelXARA window.
· Double-click the file from the File Manager (or equivalent).

If CorelXARA is already displaying a document, you are asked if you want to close it before 
displaying the new document. 

CorelXARA keeps track of the documents of the most recently viewed files. You can quickly 
open any of these by selecting its name from the bottom of the File menu.

When you finish viewing a document and you want to remove it from your screen, close it by
using the Close command.

Dialog Box Options

Windows 95: CorelXARA uses the standard Windows 95 Open dialog box and not that shown above.

File Name
Select or type the name of the document you want to open. This box lists documents of the 
type selected in the List Files Of Type box. To see a list of files with a particular file 
extension (suffix), type an asterisk (*), a period, and the three-character extension, and then
press ENTER. To see files with more than one filename extension, type a semicolon (;), a 
second asterisk (*), a period, and another three-character extension. For example, if you 
want to see all files with the .ART extension and all files with the .BMP extension, type 
*.doc;*.bmp.

List Files Of Type
Select the type of file you want to see in the File Name list.
All Files (*.*)

Lists all files in the current directory or folder.
CorelXARA Documents (*.ART)

Lists all files in the current directory or folder that were saved with the .ART extension.



Other File Types
Supported File Formats lists the other file types that CorelXARA supports and their file 
extensions.

If you drop a file onto the Viewer window or use a generic translator such as Bitmap or EPS, 
the Viewer checks the file and selects a suitable translator. Usually the file is translated 
correctly. However, occasionally the file format is ambiguous and the file is not correctly 
translated. If this happens, select the specific translator and try again.

Drives
Select the drive that contains the file you want to open.

Directories
Select the directory that contains the file you want to open.

Network
Opens the Connect Network Drive dialog box so that you can make a connection to a 
network 
drive. For more information, click the Help button in the dialog box.

Key Short-cut
CTRL+O



Close Command (File Menu)
Closes the active document.

If you have multiple windows open for a single document, the Close command on the 
Document control menu closes only one window at a time. To close all windows at the same 
time, choose the Close command from the File menu.
_______________
See also
Exit Command



Document Info Command (File Menu)

This command opens the Document Information dialog which displays statistics about the current 
document.



1,2,3,4 Command (File Menu)
Use the numbers and names listed near the bottom of the File menu to open any of the 
documents recently viewed. Select the number or name that corresponds to the document 
you want to open.



Exit Command (File Menu)
Ends a Viewer session. 

You can also exit CorelXARA by either:
· Opening the application control menu by pressing ALT+SPACEBAR. Then choose Close. 
· Double-clicking the application Control-menu box.



Utilities Menu
Clipart Gallery Command
Font Gallery Command
Time Redraw Command



Clipart Gallery Command (Utilities Menu)

This command opens the Clipart Gallery.

Key Short-cut
SHIFT+F10



Font Gallery Command (Utilities Menu)

This command opens the Font Gallery.

Key Short-cut
SHIFT+F9



Time Redraw Command (Utilities Menu)
This tells how long CorelXARA Viewer took to redraw the current document. We know 
CorelXARA is fast - Time Redraw lets you see exactly how fast. Viewer uses background 
redraw, updating every half second. The main CorelXARA program has an option to turn off 
background redraw. which speeds up redraw considerably so only use Viewer redraw times 
as a guide. (Screen redraw also depends on how much memory is in the computer and on 
the complexity of the image.)

To time redraw of a file, open the file and click the Time Redraw button on the Button Bar.

To get a fair comparison of the speed of CorelXARA to the speed of other programs you 
should:

1. Load the file into CorelXARA.
2. Scale it the same size as it is in the other program's window.
3. Set the View Quality down to Normal (so that CorelXARA doesn't anti-alias).
4. Select Time Redraw.

CorelXARA's Anti-Aliasing  slightly slows down screen redraws (but gives you much better 
image quality).



Window Menu
Arrange Views Command
Cascade Command
Arrange Icons Command
Full Screen Command
Quality Command

_______________
See also
CorelXARA Commands



New View Command (Window Menu)
This option opens another view onto the current document.    If you have multiple views open onto a 
document, each view can have a different Quality Control setting.



Arrange Views Command (Window Menu)
This option tiles all the open document views to fill the Viewer window.



Cascade Command (Window Menu)
This option stacks the open document views along a diagonal line.



Arrange Icons Command (Window Menu)
This option arranges the icons of all minimised documents in the bottom left-hand corner of the main 
CorelXARA window.



Full Screen Command (Window Menu)
CorelXARA works in two modes. Normal and Full Screen. Each mode has its own display settings. 
CorelXARA remembers the current settings which then apply next time that mode is entered. This makes 
it possible to switch between two completely customised modes.

You can toggle between normal and full screen modes using either the option on the Window menu or the
button on the Button Bar.

To display the menu bar in full screen mode:
Move the mouse pointer to the top of the screen.



Quality Command (Window Menu)

The Quality submenu on the Window Menu and the Quality slider on the Button Bar controls how 
CorelXARA displays the current view. There are four options on the Window menu:

Anti-aliased
The highest quality setting. All edges are anti-aliased to reduce on-screen jaggies and give the same 
effect as a higher resolution screen.

Normal
Not anti-aliased and so faster. Full blends and smooth 256 step graduated fills.

Simple
No graduated fills shown. Reduced number of steps in blends.

Outline
No solid colours shown - only outlines (even for those with no outline colour). This type of display is 
sometimes called 'wire frame'.

The slider lets you select these options and also intermediate settings.

If you have multiple views onto a document, each view can have a different quality setting.



Help Menu
Help about this program
More about CorelXARA
About CorelXARA

_______________
See also
CorelXARA Commands



Help about this program (Help Menu)
This command opens this help file and displays the contents page.



More about CorelXARA (Help menu)
This displays a specification document giving you more information on the full CorelXARA 
package.



About CorelXARA Viewer (Help Menu)
This displays general information about CorelXARA Viewer.



Other CorelXARA Commands
Previous Zoom Command
Zoom to Drawing Command
Zoom to Page Command
Zoom Command



Previous Zoom

This option on the Button Bar restores the magnification level to that which it was previously.
You can use this option to swap between two zoom values.



Zoom to Drawing

This option on the Button Bar scales the current view so the drawing fills the window..



Zoom to Page

This option scales the current view so the page fills the window.



Zoom Command

This menu on the Button Bar allows you to select a zoom from a list or type in a user defined value.
It also includes options for zooming to the Page, Drawing and returning to the Previous zoom.



Clipart Gallery
{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, CLIPGAL.BMP}

The Clipart Gallery lets you easily preview and load clipart from the CorelXARA Viewer CD 
and other sources.

The Clipart Gallery can be opened by :
· Selecting the Clipart Gallery option from the Utilities menu.
· Clicking on the Clipart Gallery button on the Button Bar.
· Pressing SHIFT+F10.

Loading Pictures
To load one of the example pictures :

· Drag it from the Clipart Gallery onto CorelXARA Viewer.
or
· Click on the picture and then click the Open button.

Options
This button opens the Gallery Options dialog. This dialog allows the gallery to be sorted and 
searched as well as offering different options for the format in which the gallery items are 
displayed.

Add clipart
Clicking this button opens a modified version of the Open dialog box that lets you select a 
clipart directory to add to the gallery. See Adding to a gallery for more details.

Remove
This lets you reduce the number of clipart categories (sections) displayed in the gallery. Click
on a section's title bar and then click Remove. This action only removes the section from the 
gallery; it does not alter the CD.
To restore the section to the gallery, use Add clipart to select the CD again.

Import
This button is disabled in Viewer. In the full CorelXARA program, clicking this button imports 
(merges) the selected file into the current drawing.

Folding and Unfolding Gallery Sections
To fold up a section in the gallery click on the folder icon next to its name or double click on 
the title strip.
_______________
See also
Selecting Items in a Gallery
Search a gallery
Close a gallery
Alter gallery display format
Re-ordering gallery sections
Re-ordering gallery items
Move & resize galleries



Font Gallery
{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, FONTGAL.BMP}

The Font Gallery allows you to view the fonts you have installed on your computer.
In the full CorelXARA program you can use the Font Gallery and drag-and-drop to apply fonts
to text in your drawings. It also allows you to quickly and easily install and de-install fonts 
from the CorelXARA CD.

The Font Gallery can be opened by :
· Selecting the Font Gallery option from the Utilities menu.
· Clicking on the Font Gallery button on the control bar.
· Pressing SHIFT+F9

In the CorelXARA Viewer the gallery only contains one section which shows the installed 
fonts on your computer, in the full version of the program you will see three sections :

· Installed fonts on your computer.
· Uninstalled fonts grouped by appearance (from the CD).
· Uninstalled fonts (complete list from the CD).

De-install
This button will de-install all selected fonts. You can only de-install fonts which are currently 
installed.

Add Library
Clicking this button opens a modified version of the Open dialog box that lets you select a 
directory of fonts to add to the gallery as a library. This option will only work if you have the 
full CorelXARA CD, the Viewer does not include any fonts..

Options
This button opens the Gallery Options dialog from where the font gallery can be sorted (see 
Re-ordering gallery items) and searched. The dialog can also be used to alter the format of 
the information displayed in the gallery (see Altering gallery display format).



Status Line

The Status Line text tells you what options are currently available to you. Also, if an operation takes more 
than a few seconds (for example, loading a complicated file), the Status Line shows a progress bar.

On the right-hand side of the Status Line is the Transparency indicator. This shows when a document 
uses CorelXARA's advanced transparency option. For more information see More about CorelXARA.



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP} 
Clipart Gallery

· Closing the gallery
· Selecting items in the gallery
· Moving & resizing the gallery
· Re-ordering gallery items
· Re-ordering gallery sections
· Searching the gallery
· Altering gallery display format
· Adding pictures to the gallery

Miscellaneous
· Zooming
· Moving the page



Gallery How



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP} Close 
a gallery

Click on the icon in the top left-hand corner of the gallery.

When a gallery is open, its button on the Button Bar is pressed in - the gallery can be closed by clicking 
the button again to pull it out.



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP} Select 
items in a gallery

The Clipart Gallery allows you to perform operations on pictures (loading, importing etc). 
Before you can perform an operation, you must select the picture(s) in the gallery. Selected 
items are shown highlighted. In the same way you must select fonts in the Font Gallery 
before you can de-install them.

Selecting a Single Item
Click on the item.

Selecting Several Items
1. Click on the first item,
2. Ctrl-click on each subsequent item

Selecting a Block of Items
1. Click on the first item in the block,
2. Shift-click on the last item in the block. This also selects items between the first and last 

items.



{ewc oshtools.dll, OlsonSoftEWBitmap, HOWTO.BMP} Move & 
resize a gallery
You move and resize the Galleries in the same way as other windows. That is, drag the Title 
Bar to move the gallery and drag the edges of the gallery to resize it.



{ewc oshtools.dll, OlsonSoftEWBitmap, HOWTO.BMP} Re-order 
gallery items
Items can be re-ordered simply by dragging them around within the gallery. The gallery 
contents can also be sorted from the Gallery Options dialog accessible from the Find button 
on the gallery.

See also Re-order gallery sections



{ewc oshtools.dll, OlsonSoftEWBitmap, HOWTO.BMP} Re-order 
gallery sections
Drag the Title strip (the bar showing the name of the section) up or down the gallery to 
move a section before or after another section.

See also Re-ordering gallery items



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP} Search
a gallery

1. Click the Options button in the gallery.

2. Click Find. This opens the Find dialog.

3. Type in the search name.
Items in the Clipart gallery also contain information about their subject. For example, you 
can search for "Insect" and find all entries that show insects. (Any items you add to the 
gallery will not contain subject information.)

4. Click Find first to find the first match or Find next for subsequent matches.



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP}    Alter 
gallery display format

1. Click Options. This opens the Options dialog.

2. Select the display option you require such as large icons, small icons, and so on.
Entries are initially sorted according to Primary key. (In the illustration, by name in 
alphabetic order.)
Particularly when sorting by name length or file size, there may be two files with identical 
name lengths or file sizes. In this case, these entries are further sorted by the Secondary 
key.

3. Click Apply.
_______________
See also
Re-ordering Gallery Items
Re-ordering Gallery Sections



{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, HOWTO.BMP}    Add 
to the Clipart Gallery

You may want to include more clipart to the Clipart Gallery. To do this you add a folder (or 
directory) containing the pictures you want to add. You can add more items to an existing 
folder and also include these items in the gallery. Folders contain the items and an index of 
the items.)

To add a new folder, first copy the items you want to add into a separate directory.
To add to an existing folder, copy the new items into the existing folder.

Click Add clipart. This opens the Add Folder dialog box:

To select the folder either:
· Select from the Drives menu.
· Click Network to add a drive from the network (if your computer is connected to a 

network).
· Click FindCD to select the CD drive on your computer.
then select the directory in the usual way.

Adding a new folder
Select the directory then click Add. This adds the folder as a new section in the gallery.

Clipart gallery: you will be asked if you want to include previews; choose NO if the new 
files are all CorelXARA files otherwise choose YES. (Previews are the small images that 
appear in the gallery.)

Adding to an existing folder
Select the directory then click Update.



Other



{ewc oshtools.dll, OlsonSoftEWBitmap, HOWTO.BMP} Zoom
Previous Zoom

Previous Zoom Command (Button Bar)

View Entire Drawing

Zoom to Drawing Command (Button Bar)

View the Entire Page

Zoom to Page Command (Button Bar)

Pre-set Magnifications

Zoom Command (Button Bar)
(Zooming in, out and on specific areas).

Zooming In and Out

Select the Zoom Tool
Click the mouse to zoom in on the document.
SHIFT-click (or right-click) the mouse to zoom out from the document.
The Status Line displays the zooms that will occur with mouse clicks.

Zooming on a Specific Area of a Document

Choose the Zoom Tool.
Drag the mouse to create a rectangle around the area.



{ewc oshtools.dll, OlsonSoftEWBitmap, HOWTO.BMP} Move the 
page
To move the page

1. Choose the Push Tool.
2. Place the pointer over the page and drag. The page will follow your movements.

You can also move the page using the Scrollbars.



Link Topics



Anti-Aliasing
Anti-aliasing improves the quality of on-screen images by inserting extra pixels of calculated 
colours around the edges of objects on screen. This has the effect of smoothing the edges 
and of appearing to improve the resolution of the display.

{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, SMOOTH1.BMP}           



Supported File Formats
The following is a list of the file types which can be imported into CorelXARA Viewer.

If you drop a file onto the Viewer window or use a generic translator such as Bitmap or EPS, 
the Viewer checks the file and selects a suitable translator. Usually the file is translated 
correctly. However, occasionally the file format is ambiguous and the file is not correctly 
translated. If this happens, select the specific translator and try again.

The full version of CorelXARA supports a slightly wider range of file formats than are listed 
here.

Bitmap Import Formats
.301 Brook Trout
.BM X Windows (2 colour)
.BMP Windows Bitmap
.CAL    CALS (2 colour)
.CUT Halo CUT (256 colour)
.DCX DCX
.GIF CompuServe Graphics Interchange Format
.GX2 GX2
.ICA IOCA (2 colour)
.ICO Microsoft Windows Icon (16 colour)
.IFF IFF
.IMx Sun Raster
.IMG IMG (16 colour)
.JPG JPEG
.i KOFAX
.LV LaserView (2 colour)
.MAC MacPaint (2 colour)
.MSP Microsoft Paint (2 colour)
.PCD PhotoCD
.PCTPICT
.PCX PCX Paintbrush
.PSD PhotoShop
.RAS Sun Raster
.TGA TrueVision TARGA
.TIF TIFF
.WPG Word Perfect Group (256 colour)
.XBM X Windows (2 colour)
.XPM X Windows (256 colour)

EPS Import Formats
.AI Illustrator EPS (88, 3, 4)
.EPSIllustrator EPS (88, 3, 4)

Other Import Formats
.ARTCorelXARA
.CDR CorelDRAW (3,4 & 5)
.WMF Windows Meta File

Note
The CorelDRAW importer included in the full CorelXARA program is better than that supplied with Viewer. CorelXARA
Viewer will sometimes not import some objects correctly.
Bitmap import filters are licensed from AccuSoft Corporation. The full version of CorelXARA allows all bitmaps and 
illustrations to be exported in most of these formats.
_______________
See also
Open Command



Photo CD Files
PhotoCD is a Kodak proprietary process for storing photographs and transparencies in digital
form on a CD. The CD can contain up to six copies of each image at different resolutions. 
These are defined by Kodak as :

Name Resolution Memory Required
Base/64 96x64 24Kb
Base/16 192x128 96Kb
Base/4 384x256 384Kb
Base 768x512 1.5Mb
Base*4 1536x1024 6Mb
Base*16 3072x2048 24Mb

Base/64 is used for 'thumbnail' previews of the image.

The generic bitmap translator loads the Base image (768x512 pixels).
The PhotoCD loader opens a dialog box that lets you select which image to load.



Window Controls
The following are the controls available to manipulate the CorelXARA window and its 
document windows.

Arrange Views Command
Cascade Command
Arrange Icons Command
Full Screen Command



On-line Demonstration
This lets you see more of the features available in the full CorelXARA package.

If your machine uses a screen-saver, we suggest you disable it during the demonstration 
(The Windows User Guide describes how to disable a screen saver). Note that you will only 
hear the sound track of the demonstration if your computer is fitted with a sound card.

{ewc OSHTOOLS.DLL, OlsonSoftEWButton, "      ":ExecProgram("XaraDemo 
intro.avi CorelXARA Demonstration"\.0)}    Click this button to start the 
demonstration of CorelXARA.



Re-installing Win32s
This section applies only if:

you are running Windows 3.x
and you have to re-install your Win32s extension software.

You may find you cannot re-install Win32s (supplied with Viewer) after re-installing your 
windows software as the Win32s installer claims the software is already installed. The 
following instructions describe how to remove Win32s, it is then possible to complete a new 
installation.

1. Remove the following line from the [386Enh] section in the SYSTEM.INI file:
                device=<WINDOWS>\<SYSTEM>\win32s\w32s.386

where <WINDOWS> and <SYSTEM> are where the Windows and System directories are, 
respectively.

2. Modify the following line from the [BOOT] section in the SYSTEM.INI file:
            drivers=mmsystem.dll winmm16.dll

to the following (remove winmm16.dll):
            drivers=mmsystem.dll

3. Delete the following files from the <WINDOWS>\<SYSTEM> subdirectory or
      from the SYSTEM directory in network installations:
            W32SYS.DLL
            WIN32S16.DLL
            WIN32S.INI

4. Delete all the files in the <WINDOWS>\<SYSTEM>\WIN32S subdirectory or the 
<SYSTEM>\WIN32S subdirectory in network installations.

      Then delete subdirectory itself.

5. Restart Windows.

NOTE: <WINDOWS> refers to the windows installation directory. On a networked Windows 
installation, the system directory may be located on a remote share. If you are only 
removing Win32s from your machine, then you do not need to remove the shared files (in 
<SYSTEM> and <SYSTEM>\WIN32S). Before removing these files from the network share, 
make sure that all users that use Win32s have removed the references to Win32s from the 
SYSTEM.INI file.



Corel and Xara On-line
Corel Corporation and Xara Ltd (developers of CorelXARA) are both present on the Internet.

Xara Ltd
Email info@xara.com for general queries
WWW www.xara.com

Corel Corporation
Email custserv@corel.com
WWW www.corel.com



Xara Ltd

{ewc OSHTOOLS.DLL, OlsonSoftEWBitmap, GADDES.BMP}
Xara Ltd are the developers of CorelXARA and a Corel Reseller

Xara is a new company set up by Computer Concepts Ltd. to develop CorelXARA (originally 
known as Xara Studio). Computer Concepts have been developing mainstream application 
software since 1981. CC was one of the pioneer microcomputer software houses of the early 
eighties in the UK developing applications such as the Wordwise word processor which sold a
quarter of a million copies.

With nearly 15 years of development experience, the last six of which have been developing
32-bit windowing based applications for RISC based computers, this has given us an 
unrivalled experience of developing microcomputer application software. This experience 
predates the arrival of 32-bit Windows based environments by many years.

The recent arrival of 32-bit Windows programming environments (Windows 95, Windows NT 
and Windows 3.1 with Win32s) has meant we can now exploit that experience in the wider 
PC and Windows market, rather than the more niche markets we occupied before.

The CorelXARA project was started at the beginning of 1993 and currently involves 22 
programmers based at our headquarters, Gaddesden Place (pictured above).

Xara Ltd have a strong presence on the Internet (see Corel and Xara On-line) and provide a 
support and feedback service via www.xara.com.

          Xara Ltd
Gaddesden Place
Hemel Hempstead
Hertfordshire HP2 6EX
United Kingdom

Tel: 01442 350000
outside UK +44    1442    350000

Fax: 01442    350010
outside UK +44 1442 350010

WWW www.xara.com
Email info@xara.com






